
 
 
 

 
 http://www-01.ibm.com/software/support/acceleratedvalue/ 

IBM Software Accelerated Value Program  
 

 
 
 
 
 
 

AVP - 2932 

IBM WebSphere Process Server V7 
Problem Determination  

   

 

 
  
 



 
 

   
 

2 

IBM Software Accelerated Value Program 
 

http://www-01.ibm.com/software/support/acceleratedvalue/ 

Exercise - Troubleshooting an SCA application with runtime 
errors 

 

 

At the end of the exercise, you should be able to: 

• Load a log file onto the Server Logs viewer in WebSphere Integration Developer 
in order to analyze error messages  

• Deploy SCA applications onto WebSphere Process Server  
• Monitor the health of deployed applications through the Health Monitor Wizard 

in Business Space 
• Utilize cross-component trace to follow the call sequences between SCA 

applications 
• Query failed events through the Failed Event Manager and resubmit the events 

after the problem is resolved 
 

 

Overview: 

In the first part of the exercise, you are going to import the given SOA  
solution. After examining the end-to-end solution, sample data gets sent through a 
JSP application. The test will fail, and your task is to troubleshoot this runtime error. 
In this section the cross-component trace feature in the WebSphere Integration 
Developer is explored. The exercise demonstrates how to trace back to the point of 
failure in the assembly diagram. 
 
In the second part of the exercise, you are going to explore some of  
the runtime applications: Failed Event Manager, service integration 
bus browser, Business Process Choreographer Explorer, as well as  
Business Space. After the problem is resolved, the failed event must be resubmitted 
using the Failed Event Manager.  
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Exercise instructions 

Part 1: Set up the environment 

 
__ 1. Open a new workspace: C:\WID\workspace 

__ a. Start WebSphere Integration Developer if it is not already started. 

__ b. Select the workspace to be C:\WID\workspace and click OK.  

 

Note: If WebSphere Integration Developer is already opened, select File > Switch 
Workspace..., enter C:\WID\workspace in the Workspace field, and then click OK. 

 

__ c. Close the Getting Started pane.  

 

__ 2. Import C:\WID\SCA-PD-2011.zip into your workspace. 

__ a. Select File > Import.... 

__ b. Select Project Interchange under the Other folder as the import source type. 
Click Next. 

__ c. Click Browse... button for From zip file field.  

__ d. Navigate to C:\WID\SCA-PD-2011.zip.  
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__ e. Click Open. 

__ f. Click Select All. 

 

__ g. Click Finish. 

 

End-to-end scenario overview 

This end-to-end scenario demonstrates a fictional retail company’s SOA implementation to 
centralize a customer account creation process.  
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There are three mediation modules that mediate the incoming events and execute some 
data manipulation logics.  
 
There is a service module named FoundationModule, which contains the main business 
logic, AccountVerification BPEL, to process the account creation logic.  
 
The FoundationServices module contains services to help the FoundationModule to 
complete customer account verification tasks.  
 
Since human interaction becomes necessary to approve customer requests, the 
HumanTaskServices module contains the human task components.  
 
First, a sales person enters customer information through a Web application, which triggers 
an instance of the AccountVerification business process to be created.  
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This is defined in the FoundationModule. 
 

 
 
Open the AccountVerification interface by right-clicking and selecting Open. You will see 
that CustomerApplication is the data type that gets passed to the process.  
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In the Business Integration view, expand FoundationLibrary > Data Type > 
creditserviceitems to locate the CustomerApplication business object. Double-click 
CustomerApplication to view its definition. 
At run time, customer’s application eligibility gets evaluated.  
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The flow of AccountVerification business process is that the data gets routed to the Map to 
Ineligible  invoke activity if the eligibleApplication parameter value is set to false. Otherwise, 
the business event flows to the Initial Review activity. 
 
Double-Click on AccountVerification in the FoundationModule Assembly Diagram to take a 
closer look. 
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If the eligibleApplication parameter value is set to false, the request for an account creation 
gets rejected. The customer information gets archived in a local directory, as well as in a 
database. 
 

Note: In the workshop we will not be exercising the “Map to Ineligible” path of the business 
process. 

 

Part 2: Test the imported SOA solution 

In this section, you are going to test the given SOA solution.  
 
__ 1. If the server is not running already, start the server.  

__ a. In the Servers tab, right-click WebSphere Process Server v7 at localhost and 
select Start from the context menu. 

__ b. Wait until the server status changes to Started. This may take up to 5 minutes. 
(Note: You may see an error in the logs related to the TAI, this is expected and we 
are not using this functionality) 

 

__ 2. Deploy the imported applications. 

__ a. In the Servers tab, right-click WebSphere Process Server v7 at localhost and 
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select Add and Remove Projects... from the context menu. 

__ b. In the Add and Remove Projects, click Add All. 

 

__ c. Click Finish. Wait until it completes. 
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__ 3. Clear the Server Logs view before executing a test. 

__ a. In the menu bar in the Server Logs view, click the Clear Server Console icon 
which can be found towards the right of the task bar. 

Note: This is an optional task. You do not have to perform this task; however, this makes it 
easier for you to find certain output messages during the test. 

 
__4. Create a new account opening request to test the CreateApplication task user 

interface JSP. 

__ a. Open a Web browser, and type the following address in the address field:  

https://localhost:9443/AccountOpeningUI.  

     This opens the login page for your account creation user interface. Depending on 
which browser is used you will need to handle the certificates by either selecting 
OK or yes when prompted. You may also need to, when the Certificate Error 
window appears, select the Continue to this website (not recommended) link 
to proceed to the authentication page. 

__ b. At the Login window, enter admin in the Name as well as Password fields. 

 

__ c. Click Login. 

__ d. Click New on the main page. 
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__ e. CreateApplication is the only available task. Click the link. 

 

__ f. On the CreateApplication screen, fill in the data fields. In order to demonstrate 
the data flow, use the companyName of IBM 

     You may leave rest of the fields blank. 

 

Note: The contents of these fields get populated by the DetermineApplicantEligibility 
service for IBM so that you do not need to enter values for all fields.  
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__ g. Click Create. The Web browser will return to the Business Cases > New page. 

     The AccountVerification business process template defines the application 
review process, as follows: If the value entered for eligibleApplication is true, 
then the CustomerApplication data goes to the InitialReview activity. 
Otherwise, the data would flow through the MaptoIneligible activity.  

 

     In this test case, eligibleApplication is set to true. Therefore, the InitialReview 
activity gets invoked. This service is provided by InitialReviewPartner, which is 
the InitialReview business process in the FoundationModule.  

 

     The InitialReview business process invokes the Initial Application Review to-do 
(participating) task.  

 

__ 5. Examine the output messages. 

__ a. Click the Server Logs tab. 

__ b. In order to see the entire logged messages, click the Select Records to Display 
icon, and then select All Record Types (Hierarchical) > with All Contents. 
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__ c. You should see messages from the human task container, “CWTKE0044I: 
Originator becomes administrator of task InitialApplicationReview.” 

 

Note: Log messages with the CWTK prefix indicate human task-related messages. The “I” 
indicates that it is an informational message. Here is the definition of CWTKE0044I: 
CWTKE0044I: Originator becomes administrator of task {0}. Usually this happens, because 
no people assignment criteria is defined for the administrators of the task, or because its 
usage returns an empty set of users. 

 

Explanation: Because administrator could not be found, the task’s originator will  

also be the task’s administrator. This can occur when either the task’s people  

assignment criteria (staff verb) for administrator return an empty set of users, or  

when this people assignment criteria are not defined. 

 

User Action: If this is not what you want, check the people assignment criteria (staff verb): 
Maybe the people assignment criteria need to be changed, or you need to define a people 
assignment for the administrators of the task. 

 
__ 6. Complete the InitialApplicationReview work item. 
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__ a. In the Web application, click Open under My ToDo’s. There should be a work 
item, InitialApplicationReview, ready for completion. 

 

__ b. Select the link, and click Claim. 

__ c. There is no need to change the Output Data; therefore, click the Complete 
button without making any modifications. 
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__ d. Examine the output in the Server Logs view. 

 

     You should see the exceptions being thrown in the Server Logs view. Now, your 
task is to troubleshoot this runtime error. 

 

Part 3: Troubleshoot the AccountVerification service failure 

For the lab purpose, the problem introduced here is a very simple one to  
troubleshoot. The main purpose of this section is to demonstrate different tools that are 
available for you to troubleshoot runtime problems.  
 
__ 1. Rerun the test with cross-component trace enabled. 

__ a. Select the Server Logs tab.  

__ b. Access cross-component trace settings by clicking the View Menu arrow at the 
far right upper corner of the Server Logs toolbar. 

 

__ c. Enable cross-component trace by selecting Cross-Component Trace State > 
Enabled with Data Snapshot from the view menu. 

 

Note: You may want to clear the Server Logs view again before sending another event. 
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__ d. From the JSP page, send the test data for company, IBM again,  by creating a 
new entry. Now that you enabled the cross-component trace, you can see the 
event flow.  

__ e. In the Server Logs view, the focus should be on the End component 
(InitialApplicationReview:InputCriterion). Right-click the entry and select Show 
Component in Assembly Diagram from its context menu. 

 

__ f. The HumanTaskServices assembly diagram should be opened with the 
InitialApplicationReview human task component highlighted. 

 

     The InitialApplicationReview work item is now ready for you to claim and 
complete. 

 

__ 2. Claim and complete the InitialApplicationReview work item. 

__ a. In the JSP application, click Open under My ToDo’s. There should be a work 
item, InitialApplicationReview, ready for completion. 
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__ b. Select the link, and click Claim. 

__ c. Click the Complete button without making any modification. 

__ d. Examine the output in the Server Logs view. 

__ e. In the menu bar in the Server Logs view, click the Expand icon. 

 

__ f. Locate the very first Exception message, and double-click the entry to view its 
contents. The exception will be found in a Log message with the error code 
CWWBE0057I 
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This message indicates that the target service was not found. 

__ g. Right-click the Start import(CreditCheckService:InputCriterion) right above 
the first Fail Invoke, and select Show Component in Assembly Diagram. 

 

__ h. The FoundationModule assembly diagram should open, and the 
CreditCheckService import component with Web service binding should be 
highlighted. 
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__ i. Right-click the CreditCheckService import component and select Show in 
Properties. This displays the properties of the import component. 

__ j. Select the Binding tab. 

 

__ k. The exception indicated that the 
https://localhost:9443/CreditCheckServiceWeb/sca/CreditCheckServiceExport is 
not running. 

 
__ 3. Launch the administration console to see if the CreditReportService exists. 

__ a. Launch Internet Explorer and enter the following address to open the 
administrative console:   

https://localhost:9043/ibm/console 

__ b. Select OK or Yes on any prompts to proceed to the login page. 

__ c. Enter admin in the User ID and Password fields and click Log in. 

__ d. Expand Applications and select Enterprise Applications from the left pane.  
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     Notice that CreditCheckService application cannot be found on the server. 

 

 

__ 4. Check the entries in the Failed Event Manager. 

__ a. In the Server Logs view, there was an entry indicating a failure incident 
occurred. Let’okays now look at the “failed event manager” 

__ b. In the administration console, expand Integration Applications and select Failed 
Event Manager in the left pane.  

__ c. Select Get all failed events under the Failed events on this server section. 

 

__ d. You should see at least two failed events, since you sent events twice. 
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__ 5. Use the Business Space to check the system health. 

    Business Space is a common interface for application users to create, manage, and 
integrate Web interfaces across the WebSphere Business Process Management 
portfolio. This tool is mostly for business users. 

  

__ a. In the Servers view, right-click WebSphere Process Server v7 and select 
Launch > Business Space. 

 

__ b. When the Security Alert dialog box appears, click Yes to continue. 

__ c. At the login window, enter admin for both user ID and password. 

__ d. At the Welcome panel, click the Manage Spaces link in the menu.  
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__ e. Now select System Health from under the Problem Determination section. 

__ f. Click the Applications tab to see which services have been started on the server. 

 
 

Note: Notice that the number of Total Failures in the Failed Events pane is the same as what 
the Failed Event Manager displayed. 
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     When you are done exploring the Business Space, close it. 

 
__ 6. The AccountVerification service was implemented as a long-running business 

process. Launch the Business Process Choreographer Explorer to see current running 
process instances. 

__ a. Launch Internet Explorer and enter the following address to open the 
administrative console:   

http://localhost:9080/bpc/ 

__ b. At the login page, enter admin in the User ID and Password fields and click 
Login. 

 

__ c. Click Started By Me under Process Instances. 

 

     You should see two running instances which have not been completed due to the 
failed events. 



 
 

   
 

25 

IBM Software Accelerated Value Program 
 

http://www-01.ibm.com/software/support/acceleratedvalue/ 

__ d. Select one of the running instances to view detailed information. 

__ e. Click the Activities tab, and notice that the CreditCheckService activity is in 
stopped state. In other words, this process instance has failed, and the process 
cannot continue due to failure to invoke the external Web service. 

 
 
__ 7. The missing service is provided in the C:\WID\CreditCheck.zip file. Import the Web 

service and deploy it onto the server. 

__ a. Select File > Import.... 

__ b. Select Project Interchange under the Other folder as the import source type. 
Click Next. 

__ c. Click the Browse... button for the From zip file field.  

__ d. Navigate to C:\WID\CreditCheck.zip.  

__ e. Click Open. 

__ f. Click Select All (there is only one project). 

__ g. Click Finish. 

__ h. In the Servers tab, right-click WebSphere Process Server v7 at localhost and 
select Add and Remove Projects... from the context menu. 

__ i. In Add and Remove Projects, select CreditCheckServiceApp, and click Add >. 

__ j. Click Finish. 
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     Wait until CreditReportServiceApp is started. 

 
__ 8. Resubmit the failed events through Failed Event Manager to complete the process. 

__ a. In the administration console, expand Integration Applications and select Failed 
Event Manager in the left pane.  

__ b. Select Get all failed events under the Failed events on this server section. 

 

__ c. Click one of the Event IDs to see its details. 
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__ d. Clicking View business data enables you to make a modification to the event 
message. 

__ e. Clicking the request link will display the content of this CreditCheckDetail 
business object instance. 

 

__ f. In this case, there is no need to edit the message. Therefore, click Resubmit 
without making any changes. 

__ g. A message should indicate that the event resubmission was successful. 
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__ h. Return to the list of failed events.  

__ i. Select the check box next to the failed event. 

 

__ j. Click Resubmit to submit the rest of the failed events.  

__ k. A message should indicate that the event resubmission was successful. 

__ l. In the Server Logs view, the cross-component trace continues with the hanged 
process to complete them. You should be able to find the logs indicating that the 
failed events were resubmitted successfully. 

 
__ 9. Examine the cross-component trace logs. 

__ a. View  the Server Logs view. 

     Since the cross-component trace was enabled with data snapshot, you can view 
the data. 

 

Note: Once you enable the cross-component trace, the server logs can grow quickly. If you 
need to go back to the previous page of the log, click the Go to Page icon. 

 

     Enter the page number you wish to go to. 
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     Click OK to view the log entry in a different page. 

Note: The Credit Check Service returns a random number between 1 and 11 which defines 
the Credit Score. If the Credit Score is less than 4 is a high Credit Risk. In this case “More 
documentation is requested”. However, if the risk is Medium only a “Final Review” is needed. 
People with “low risk” are automatically approved for the loan. 

__ b. Go back to Application web and review “My ToDo's” for next step in the 
process. Remember you might end up with a different result depending upon your 
credit risk. Study the logs to understand what happened in your case. 

 
 

Note: If you cannot locate the some entry in the Server Logs view, you simply need to click 
the Expand icon to collapse the process tree. 
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__ c. Double-click Start submit callback (CreditRiskAssessment:InputCriterion) to 
view its content. 

__ d. If the creditRisk value is HIGH, follow the next steps. If the creditRisk is 
MEDIUM then go to step (i). If the creditRisk is LOW then go to step 10. 

 

__ e. In the Web application, click Open under My ToDo’s. There should be a work 
item, RequestMoreDocumentation, ready for completion. 
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__ f. Select the link, and click Claim. 

__ g. Change the text in the comments field from None to Approved. 

 

__ h. Click Complete. 

__ i. In the Web application, click Open under My ToDo’s. There should be a work 
item, FinalApplicationReview, ready for completion. 
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__ j. Select the link, and click Claim. 

__ k. Click Complete. 

 
__ 10. Return to the Business Process Choreographer Explorer to verify that there are no 

more running process instances. 

__ a. Click Started By Me under Process Instances. 

 
 

Note: You might want to test with multiple “Create Application” scenarios in order to get a 
different Credit Risk generated and thus a different result. 

Part 4: Clean up the environment 

__ 1. Remove all of the deployed projects from the server. 

__ a. In Servers view, right-click WebSphere Process Server v7, and select Add and 
Remove Projects from its context menu. 
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__ b. Click the << Remove All button. 

 

__ c. Click Finish. 

End of exercise 
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Exercise review and wrap-up 

In this exercise, you learned how to utilize the cross-component trace to find the service 
component where the failure first occurred. In case of a long-running business process, the 
service invocation is always asynchronous. Therefore, the failure gets captured by the 
Failed Event Manager. Once the problem was fixed, the failed events could be resubmitted 
for completion. You also saw that the business process instances can be monitored using 
the Business Process Choreographer Explorer. The problem presented in this exercise was 
very simple to detect. However, the techniques in which you learned to use cross-
component trace can be applied to every SCA application.   


